# Table of Contents

## 1 INTRODUCTION

1.1 About this Manual

- 1.1.1 Descriptions of the Dialog Panes
- 1.1.2 Online Help
- 1.1.3 List of Revisions
- 1.1.4 Conventions in this Manual

1.2 Legal Notes

- 1.2.1 Copyright
- 1.2.2 Important Notes
- 1.2.3 Exclusion of Liability
- 1.2.4 Warranty
- 1.2.5 Export Regulations
- 1.2.6 Registered Trademarks

1.3 About EtherCAT Generic Slave DTM

- 1.3.1 Requirements

1.4 Dialog Structure of the EtherCAT Generic Slave DTM

- 1.4.1 General Device Information
- 1.4.2 Navigation Area
- 1.4.3 Dialog Pages
- 1.4.4 OK, Cancel, Apply and Help
- 1.4.5 Table Lines
- 1.4.6 Status Bar

## 2 GETTING STARTED

- 2.1 Configuration Steps

## 3 CONFIGURATION

3.1 Overview Configuration

3.2 Configuring Device Parameters

3.3 General

3.4 Behavior

- 3.4.1 State Machine Timeout
- 3.4.2 Device Check-up
- 3.4.3 Process Data
- 3.4.4 Watchdog

3.5 Distributed Clock

- 3.5.1 Sync 0
- 3.5.2 Sync 1

3.6 Process Data

- 3.6.1 Sync Manager
- 3.6.2 PDO Assignment (Index 0x1C10- 0x1C1F)
- 3.6.3 PDO Content (Index 0x1600-0x17FF, 0x1A00-0x1BFF)
## Table of Contents

**3.7** Mailbox ..................................................................................................................... 36  
**3.7.1** CoE ..................................................................................................................... 36

**4** DESCRIPTION ............................................................................................................. 37  
**4.1** Overview Description .............................................................................................. 37  
**4.2** XML DDF Viewer .................................................................................................... 38

**5** APPENDIX ................................................................................................................ 39  
**5.1** User Rights ............................................................................................................. 39  
**5.1.1** Configuration ...................................................................................................... 39  
**5.2** References .............................................................................................................. 39  
**5.3** List of Figures ......................................................................................................... 40  
**5.4** List of Tables ........................................................................................................... 40  
**5.5** Glossary .................................................................................................................. 41  
**5.6** Contacts ................................................................................................................ 43
1 Introduction

1.1 About this Manual

This manual provides information on how to set up EtherCAT Slave devices described with XML DDF files. These devices can be configured with the EtherCAT generic Slave DTM within an FDT Framework.

1.1.1 Descriptions of the Dialog Panes

The table below gives an overview for the individual dialog panes descriptions:

<table>
<thead>
<tr>
<th>Section</th>
<th>Subsection</th>
<th>Manual Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Overview Configuration</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>General</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>Behavior</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>State Machine Timeout</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Device Check-up</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Process Data</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Watchdog</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Distributed Clock</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Process Data</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Sync Manager</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>PDO Assignment (Index 0x1C10-0x1C1F)</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>PDO Content (Index 0x1600-0x17FF, 0x1A00-0x1BFF)</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>Mailbox</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>CoE</td>
<td>36</td>
</tr>
<tr>
<td>Description</td>
<td>Overview Description</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>XML DDF Viewer</td>
<td>38</td>
</tr>
</tbody>
</table>

Table 1: Overview Dialog Pages

1.1.2 Online Help

The generic EtherCAT Slave DTM contains an integrated online help facility.

➢ To open the online help, click on Help or press F1.
## 1.1.3 List of Revisions

<table>
<thead>
<tr>
<th>Index</th>
<th>Date</th>
<th>Version</th>
<th>Component</th>
<th>Chapter</th>
<th>Revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>12-09-27</td>
<td>0.912.x.x</td>
<td>ECATGenericSlaveDTM.dll</td>
<td>all,</td>
<td>Revised,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ECATGenericSlaveGUI.ocx</td>
<td>1.3.1,</td>
<td>Section Requirements updated,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3.4</td>
<td>Check boxes &quot;Serial number&quot; and &quot;Include WC state Bit(s)&quot; have been</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>removed in section &quot;Behavior&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3.6</td>
<td>Update of Figure 18:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Configuration &gt; Process data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3.7.1</td>
<td>Update of Figure 22:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Configuration &gt; Mailbox &gt; CoE Mailbox Settings</td>
</tr>
<tr>
<td>5</td>
<td>13-01-23</td>
<td>0.922.x.x</td>
<td>ECATGenericSlaveDTM.dll</td>
<td>1.3.1</td>
<td>Section Requirements,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ECATGenericSlaveGUI.ocx</td>
<td></td>
<td>Windows 8 added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3.4.4</td>
<td>Removed option &quot;Include WC state Bit(s)&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3.4.4</td>
<td>Removed option &quot;Serial number&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.4.2, 3.1</td>
<td>Adapted menu tree for new entry &quot;Distributed Clocks&quot;</td>
</tr>
</tbody>
</table>
1.1.4 Conventions in this Manual

Notes, operation instructions and results of operation steps are marked as follows:

Notes

Important: <important note>

Note: <note>

<note, where to find further information>

Operation Instructions

1. <instruction>
2. <instruction>

or

➢ <instruction>

Results

➢ <result>
1.2 Legal Notes

1.2.1 Copyright

© Hilscher, 2007-2013, Hilscher Gesellschaft für Systemautomation mbH
All rights reserved.

The images, photographs and texts in the accompanying material (user manual, accompanying texts, documentation, etc.) are protected by German and international copyright law as well as international trade and protection provisions. You are not authorized to duplicate these in whole or in part using technical or mechanical methods (printing, photocopying or other methods), to manipulate or transfer using electronic systems without prior written consent. You are not permitted to make changes to copyright notices, markings, trademarks or ownership declarations. The included diagrams do not take the patent situation into account. The company names and product descriptions included in this document may be trademarks or brands of the respective owners and may be trademarked or patented. Any form of further use requires the explicit consent of the respective rights owner.

1.2.2 Important Notes

The user manual, accompanying texts and the documentation were created for the use of the products by qualified experts, however, errors cannot be ruled out. For this reason, no guarantee can be made and neither juristic responsibility for erroneous information nor any liability can be assumed. Descriptions, accompanying texts and documentation included in the user manual do not present a guarantee nor any information about proper use as stipulated in the contract or a warranted feature. It cannot be ruled out that the user manual, the accompanying texts and the documentation do not correspond exactly to the described features, standards or other data of the delivered product. No warranty or guarantee regarding the correctness or accuracy of the information is assumed.

We reserve the right to change our products and their specification as well as related user manuals, accompanying texts and documentation at all times and without advance notice, without obligation to report the change. Changes will be included in future manuals and do not constitute any obligations. There is no entitlement to revisions of delivered documents. The manual delivered with the product applies.

Hilscher Gesellschaft für Systemautomation mbH is not liable under any circumstances for direct, indirect, incidental or follow-on damage or loss of earnings resulting from the use of the information contained in this publication.
1.2.3 Exclusion of Liability

The software was produced and tested with utmost care by Hilscher Gesellschaft für Systemautomation mbH and is made available as is. No warranty can be assumed for the performance and flawlessness of the software for all usage conditions and cases and for the results produced when utilized by the user. Liability for any damages that may result from the use of the hardware or software or related documents, is limited to cases of intent or grossly negligent violation of significant contractual obligations. Indemnity claims for the violation of significant contractual obligations are limited to damages that are foreseeable and typical for this type of contract.

It is strictly prohibited to use the software in the following areas:

- for military purposes or in weapon systems;
- for the design, construction, maintenance or operation of nuclear facilities;
- in air traffic control systems, air traffic or air traffic communication systems;
- in life support systems;
- in systems in which failures in the software could lead to personal injury or injuries leading to death.

We inform you that the software was not developed for use in dangerous environments requiring fail-proof control mechanisms. Use of the software in such an environment occurs at your own risk. No liability is assumed for damages or losses due to unauthorized use.

1.2.4 Warranty

Although the hardware and software was developed with utmost care and tested intensively, Hilscher Gesellschaft für Systemautomation mbH does not guarantee its suitability for any purpose not confirmed in writing. It cannot be guaranteed that the hardware and software will meet your requirements, that the use of the software operates without interruption and that the software is free of errors. No guarantee is made regarding infringements, violations of patents, rights of ownership or the freedom from interference by third parties. No additional guarantees or assurances are made regarding marketability, freedom of defect of title, integration or usability for certain purposes unless they are required in accordance with the law and cannot be limited. Warranty claims are limited to the right to claim rectification.
1.2.5 Export Regulations

The delivered product (including the technical data) is subject to export or import laws as well as the associated regulations of different counters, in particular those of Germany and the USA. The software may not be exported to countries where this is prohibited by the United States Export Administration Act and its additional provisions. You are obligated to comply with the regulations at your personal responsibility. We wish to inform you that you may require permission from state authorities to export, re-export or import the product.

1.2.6 Registered Trademarks

Windows® XP, Windows® Vista, Windows® 7 and Windows® 8 are registered trademarks of Microsoft Corporation.

EtherCAT® is a registered trademark of Beckhoff Automation GmbH, Verl, Germany, formerly Elektro Beckhoff GmbH.

All other mentioned trademarks are property of their respective legal owners.
1.3 About EtherCAT Generic Slave DTM

You can use the EtherCAT generic Slave DTM to configure the EtherCAT Slave devices described with XML DDF files within a FDT Framework.

The information necessary for the configuration of the EtherCAT Slave devices is stored within the EtherCAT Master device when using the EtherCAT generic Slave DTM and thus the Master device is configured.

1.3.1 Requirements

**System Requirements**

- PC with 1 GHz processor or higher
- Windows® XP SP3, Windows® Vista (32 bit) SP2, Windows® 7 (32 bit) SP1, Windows® 7 (64 bit) SP1, Windows® 8 (32 bit) or Windows® 8 (64 bit)
- Administrator privilege required for installation
- Internet Explorer 5.5 or higher
- RAM: min. 512 MByte, recommended 1024 MByte
- Graphic resolution: min. 1024 x 768 pixel
- Keyboard and Mouse

**Note:** If the project file is saved and opened again or if it is used on another PC, the system requirements must match. Particularly the DTM must be installed on the used PC.

**Restriction**

Touch screen is not supported.

**Requirements EtherCAT Generic Slave DTM**

Requirements for working with the EtherCAT generic Slave DTM are:

- Installed FDT/DTM V 1.2 compliant frame application
- Installed EtherCAT Master DTM
- DDF file of the devices to be configured
- The user needs to reload the Device Catalog

**Loading XML DDF files**

To add devices to the netDevice device catalog, you must import the XML DDF file of the used device via netDevice menu Network > Import Device Descriptions .... into the DDF folder of the DTM. Then the Device Catalogue must be reloaded. The folder DDF inclusively Windows® XP is located in the application data directory (All Users) of the configuration software (or from with Windows® 7 on in the C:\ProgramData\SYCONnet directory).

For further information refer to section Configuration Steps on page 16, under step 1 and 2.
1.4 Dialog Structure of the EtherCAT Generic Slave DTM

The graphical user interface of the DTM is composed of different areas and elements listed hereafter:

1. A header area containing the General Device Information,
2. The Navigation Area (area on the left side),
3. The Dialog Pane (main area on the right side),
4. OK, Cancel, Apply, Help,
5. The Status Line containing information e.g. the online-state of the DTM.

![Diagram of Dialog Structure of the Generic EtherCAT Slave DTM]

*Figure 1: Dialog Structure of the Generic EtherCAT Slave DTM*
1.4.1 General Device Information

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>IO Device</td>
<td>Name of the device</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor name of the device</td>
</tr>
<tr>
<td>Device ID</td>
<td>Identification number of the device</td>
</tr>
<tr>
<td>Vendor ID</td>
<td>Identification number of the vendor</td>
</tr>
</tbody>
</table>

Table 2: General Device Information

1.4.2 Navigation Area

The Navigation Area contains folders and subfolders to open the dialog panes of the DTM.

- Select the required folder and subfolder.
- The corresponding Dialog pane is displayed.

Hide / display Navigation

- Hiding the navigation area (above right side).
- Opening the navigation area (below left side).
1.4.3 Dialog Pages

At the dialog pane the **Configuration** or **Description** panes are opened via the corresponding folder in the navigation area.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>At the <strong>General</strong> pane EtherCAT Slave information is displayed. For further information, refer to section <strong>General</strong> on page 19.</td>
</tr>
<tr>
<td>Behavior</td>
<td>At pane <strong>Behavior</strong> the parameters of the Device checkup, the Process Data and the Watchdog are described. For further information, refer to section <strong>Behavior</strong> on page 20.</td>
</tr>
<tr>
<td>Distributed Clock</td>
<td>At the pane <strong>Distributed Clock</strong>, the DC Sync mechanism and Sync0 and Sync1 can be activated and the parameters Sync 0 Cycle Time, Sync 0 Shift Time, Sync 1 Cycle Time and Sync1 Shift Time can be determined and set. For further information, refer to section <strong>Distributed Clock</strong> on page 25.</td>
</tr>
<tr>
<td>Process data</td>
<td>At pane <strong>Process Data</strong> the parameters of the Sync Manager are displayed, the PDO Assignment and the PDO content. For further information, refer to section <strong>Process Data</strong> on page 30.</td>
</tr>
<tr>
<td>Mailbox</td>
<td>At pane <strong>Mailbox</strong> you can get information on mailbox-based data transfer and the CoE (CANopen over Ethernet) functionality. For further information, refer to section <strong>Mailbox</strong> on page 33.</td>
</tr>
</tbody>
</table>

| Description         | By use of the **XML DDF-Viewer** a DDF file can be viewed and searched through. For further information, refer to section **XML DDF Viewer** on page 38. |

*Table 3: Overview Dialog Panes*
1.4.4 OK, Cancel, Apply and Help

OK, Cancel, Apply and Help you can use as described hereafter.

<table>
<thead>
<tr>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OK</strong></td>
<td>To confirm your latest settings, click <strong>OK</strong>. All changed values will be applied on the frame application database. The dialog then closes.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>To cancel your latest changes, click <strong>Cancel</strong>. Answer to the safety query <strong>Configuration data has been changed. Do you want to save the data?</strong> by <strong>Yes</strong>, <strong>No</strong> or <strong>Cancel</strong>. Yes: The changes are saved or the changed values are applied on the frame application database. The dialog then closes. No: The changes are not saved or the changed values are not applied on the frame application database. The dialog then closes. Cancel: Back to the DTM.</td>
</tr>
<tr>
<td><strong>Apply</strong></td>
<td>To confirm your latest settings, click <strong>Apply</strong>. All changed values will be applied on the frame application database. The dialog remains opened.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>To open the DTM online help, click <strong>Help</strong>.</td>
</tr>
</tbody>
</table>

Table 4: OK, Cancel, Apply and Help

1.4.5 Table Lines

In the DTM dialog pane table lines can be selected, inserted or deleted.

<table>
<thead>
<tr>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="First Line" /></td>
<td>To select the first line of a table use <strong>First Line</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Previous Line" /></td>
<td>To select the previous line of a table use <strong>Previous Line</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Next Line" /></td>
<td>To select the next line of a table use <strong>Next Line</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Last Line" /></td>
<td>To select the last line of a table use <strong>Last Line</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Create a new Line" /></td>
<td>Create a new Line inserts new lines into the table.</td>
</tr>
<tr>
<td><img src="image" alt="Delete selected Line" /></td>
<td>Delete selected Line deletes the selected line from the table.</td>
</tr>
</tbody>
</table>

Table 5: Selecting, inserting, deleting Table Line
1.4.6 Status Bar

The **Status Bar** displays information about the current state of the DTM. The current activity, e.g. the DTM connection state, is signaled graphically via icons in the status bar.

![Status Bar](image)

*Figure 3: Status Bar – Status Fields 1 to 6*

<table>
<thead>
<tr>
<th>Status Field</th>
<th>Icon / Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DTM Connection States</td>
</tr>
<tr>
<td></td>
<td>Connected: Icon closed = Device is online</td>
</tr>
<tr>
<td></td>
<td>Disconnected: Icon opened = Device is offline</td>
</tr>
<tr>
<td>2</td>
<td>Data Source States</td>
</tr>
<tr>
<td></td>
<td>Data set: The displayed data are read out from the instance data set (database).</td>
</tr>
<tr>
<td></td>
<td>Device: The displayed data are read out from the device.</td>
</tr>
<tr>
<td>3</td>
<td>States of the instance Date Set</td>
</tr>
<tr>
<td></td>
<td>Valid Modified: Parameter is changed (not equal to data source).</td>
</tr>
</tbody>
</table>

*Table 6: Status Bar Icons [1]*

![Offline State](image)

*Figure 4: Status Bar Display Example*
2 Getting started

2.1 Configuration Steps

The following table describes the steps to configure a EtherCAT Slave device with the EtherCAT generic Slave DTM as it is typical for many cases. At this time it is presupposed that the EtherCAT Master DTM installation was already done.

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Short Description</th>
<th>For detailed information see section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add EtherCAT Slave in the Device Catalog</td>
<td>Add the Slave in the Device Catalog by importing the device description file to the Device Catalog. Depending of the FDT Container. For netDevice: - Network &gt; Import Device Descriptions.</td>
<td>(See Operating Instruction Manual netDevice and netProject)</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Load device catalog</td>
<td>Depending of the FDT Container: For netDevice: - select Network &gt; Device Catalog, - select button Reload Catalog.</td>
<td>(See Operating Instruction Manual netDevice and netProject)</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Create new project / Open existing project</td>
<td>Depending of the frame application. For the configuration software: - select File &gt; New or File &gt; Open.</td>
<td>(See Operating Instruction Manual of the Frame Application)</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Insert Master or Slave into configuration</td>
<td>Depending of the FDT Container: For netDevice: - in the Device Catalog click to the Master, - and insert the device via drag and drop to the line in the network view, - in the Device Catalog click to the Slave, - and insert the device via drag and drop to the Master bus line in the network view.</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Configure Slave</td>
<td>Configure the Slave. - Double click to the device icon of the Slave. - The generic Slave DTM configuration dialog is displayed. In the generic Slave DTM configuration dialog: - configure the EtherCAT device parameters. - close the generic Slave DTM configuration dialog via the button OK.</td>
<td>Configuring Device Parameters</td>
<td>18</td>
</tr>
<tr>
<td>6</td>
<td>Configuration Steps Master device</td>
<td>Configure the Master device via EtherCAT-Master DTM.</td>
<td>(See Operating Instruction Manual DTM for EtherCAT-Master devices)</td>
<td>-</td>
</tr>
<tr>
<td>7</td>
<td>Save project</td>
<td>Depending of the frame application. For the configuration software: - select File &gt; Save.</td>
<td>(See Operating Instruction Manual of the Frame Application)</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 7: Getting started - Configuration Steps
3 Configuration

3.1 Overview Configuration

Dialog Panes “Configuration”

The table below gives an overview about the available Configuration dialog panes descriptions:

<table>
<thead>
<tr>
<th>Section</th>
<th>Manual Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview Configuration</td>
<td>17</td>
</tr>
<tr>
<td>General</td>
<td>19</td>
</tr>
<tr>
<td>Behavior</td>
<td>20</td>
</tr>
<tr>
<td>State Machine Timeout</td>
<td>21</td>
</tr>
<tr>
<td>Device Check-up</td>
<td>22</td>
</tr>
<tr>
<td>Process Data</td>
<td>23</td>
</tr>
<tr>
<td>Watchdog</td>
<td>24</td>
</tr>
<tr>
<td>Distributed Clock</td>
<td>25</td>
</tr>
<tr>
<td>Process Data</td>
<td>30</td>
</tr>
<tr>
<td>Sync Manager</td>
<td>31</td>
</tr>
<tr>
<td>PDO Assignment (Index 0x1C10-0x1C1F)</td>
<td>33</td>
</tr>
<tr>
<td>PDO Content (Index 0x1600-0x17FF, 0x1A00-0x1BFF)</td>
<td>35</td>
</tr>
<tr>
<td>Mailbox</td>
<td>36</td>
</tr>
<tr>
<td>CoE</td>
<td>36</td>
</tr>
<tr>
<td>Overview Description</td>
<td>37</td>
</tr>
<tr>
<td>XML DDF Viewer</td>
<td>38</td>
</tr>
</tbody>
</table>

Table 8: Descriptions of the Dialog Pages Configuration

Figure 5: Navigation Area - Configuration

For information to further steps as Download Configuration or Diagnosis, refer to the Operating Instruction Manual DTM for EtherCAT Master devices.
3.2 Configuring Device Parameters

The following steps are needed to configure the device parameters using the EtherCAT generic Slave DTM:

- Configure the behavior of the EtherCAT-Slave as described in section “Behavior” at page 20.
- On the **Behavior** page set the parameters for
  - the Device checkup,
  - the **Process data**
  - and the **Watchdog**.
- Configure the process data of the EtherCAT-Slave as described in section **Distributed Clock** at page 25.
- On the **Process Data** page set the parameters for
  - the **Sync Manager**,
  - the **PDO Assignment (0x1C10-0x1C2F)**
  - and the **PDO Content (0x1600-0x17FF)**.
3.3 General

The **General** dialog page shows the **Description** of the EtherCAT Slave.

**Note:** The **Station Address** is set by the EtherCAT Master, therefore the corresponding data field is not editable.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Symbolic Name of the EtherCAT Slave station.</td>
</tr>
<tr>
<td>Device type</td>
<td>Device type as defined in the DDF</td>
</tr>
<tr>
<td>Device name</td>
<td>Device name as defined in the DDF</td>
</tr>
<tr>
<td>Product revision</td>
<td>Product revision as defined in the DDF or E²PROM</td>
</tr>
<tr>
<td>Physics</td>
<td>EtherCAT Port configuration: available ports and their types.</td>
</tr>
<tr>
<td>Station Address</td>
<td>Station Address denominates a logical address. The station address of a slave is set in the master DTM.</td>
</tr>
</tbody>
</table>

**Table 9: General Page Parameters**

**Physics** in the context of EtherCAT Port configuration is described by two characters indicating the physical interface of the connection. The coding is as follows:

<table>
<thead>
<tr>
<th>Physics</th>
<th>Port type</th>
</tr>
</thead>
<tbody>
<tr>
<td>K</td>
<td>E-Bus</td>
</tr>
<tr>
<td>Y</td>
<td>100Base-TX</td>
</tr>
<tr>
<td>F</td>
<td>100Base-FX</td>
</tr>
</tbody>
</table>

**Table 10: Coding of Parameter "Physics"**
3.4 Behavior

At the page **Behavior**, the parameters of
- the state machine timeout values
- the device checkup,
- the process data
- and the watchdog timer.

are set and displayed.

![Figure 7: Configuration > Behavior](image-url)
3.4.1 State Machine Timeout

For various transitions between states of the EtherCAT slave state machine the associated timeout values can be configured separately in the state machine timeout section of the ‘Behavior’ dialog:

- **I2P**
  This value applies to the transition from *Init* state to *Pre-Operational* state

- **P2S, S2O**
  This value applies to the transition from *Pre-Operational* state to *Safe-Operational* state and from *Safe-Operational* state to *Operational* state.

- **Back to P, I**
  This value applies to the transition from any higher state back to *Pre-Operational* state or *Init* state.

- **O2S**
  This value applies to the transition from *Operational* state to *Safe-Operational* state.

Note: These timeout values are specified in units of milliseconds.

<table>
<thead>
<tr>
<th>State Machine Timeout (ms)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>I2P:</td>
<td>3000</td>
</tr>
<tr>
<td>P2S, S2O:</td>
<td>10000</td>
</tr>
<tr>
<td>Back to P, I:</td>
<td>5000</td>
</tr>
<tr>
<td>O2S:</td>
<td>200</td>
</tr>
</tbody>
</table>

*Figure 8: Configuration > Behavior > State Machine Timeout - Configuration*
3.4.2 Device Check-up

The *device check-up* part of the **Behavior** dialog looks like:

![Device checkup](image)

*Figure 9: Configuration > Behavior > Device Check*

The following table shows which items identifying the EtherCAT device can optionally be verified during device check-up if marked in the dialog accordingly.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>VendorID</td>
<td>Device’s vendor ID (DDF or stored device-externally)</td>
</tr>
<tr>
<td>Product code</td>
<td>Device’s product code (DDF or stored device-externally)</td>
</tr>
<tr>
<td>Revision</td>
<td>Device’s revision (DDF or stored device-externally)</td>
</tr>
</tbody>
</table>

*Table 11: Parameters Behavior > Device checkup*

The values within the DDF file are verified against the corresponding information stored in the device (for example, within an E²PROM circuit), if the according check box is marked.
3.4.3 Process Data

EtherCAT supplies different command sets for reading and writing:

- a combined read/write command (LRW)
- separate read and write commands (LRD/LWR)

This option allows to choose between these alternatives:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use LRD/LWR instead of LRW</td>
<td>Logical read and write operation: If marked, separate EtherCAT read (LRD) and write (LWR) commands will be used. Otherwise, a combined EtherCAT read and write (LRW) command will be used.</td>
</tr>
</tbody>
</table>

For more information on EtherCAT read and write commands see the EtherCAT Communication Specification, version 1.0, section 6.2 “EtherCAT Services”, page 43.
### 3.4.4 Watchdog

Both the entire PDI (Process Data Interface) and all sync managers (separately) are monitored by watchdog timers.

The following rules apply for resetting the watchdog timers:

- Each access from the application controller to the EtherCAT Slave controller resets the watchdog timer of the Process Data Interface.
- Each write access to the associated memory area of a sync manager resets the sync manager’s watchdog timer.

The watchdog timeout values can be calculated using the formula given below from an individually configurable value and a common multiplier.

The “Watchdog” part of the “Behavior” dialog allows specifying the multiplier and the individual values for PDI watchdog and sync manager watchdogs.

![Figure 11: Configuration > Behavior > Watchdog](image)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set multiplier</td>
<td>Watchdog multiplier, content of the register 0x400</td>
</tr>
<tr>
<td>Set PDI watchdog</td>
<td>PDI watchdog, see note below</td>
</tr>
<tr>
<td>Set SM watchdog</td>
<td>SM watchdog, see note below</td>
</tr>
</tbody>
</table>

Table 13: Parameters Behavior > Watchdog

**Note:** The PDI & SM watchdog timeout values are calculated as follows.

- **PDI watchdog timeout** = 
  \[(\text{value of register 0x400} + 2) \times 40 \times \text{value of register 0x410}\]

- **SM watchdog timeout** = 
  \[(\text{value of register 0x400} + 2) \times 40 \times \text{value of register 0x420}\]
3.5 Distributed Clock

At the page **Distributed Clock**, the DC Sync mechanism and Sync0 and Sync1 can be activated and the parameters

- Sync 0 Cycle Time,
- Sync 0 Shift Time,
- Sync 1 Cycle Time
- and Sync1 Shift Time

can be determined and set:

![Distributed Clock](image)

**Figure 12: Configuration > Distributed Clock**

**Operation Mode**

There are three operation modes available for Distributed Clocks. These are:

- **DC unused**
- **DC for synchronization**
- **User-defined Operation Mode**
Activate DC Sync

In order to set up Sync0 and Sync1 the check box *Activate DC Sync* has to be set. Data can only be entered into this screen if the check box *Activate DC Sync* is checked. Otherwise all subsequent input fields, selection lists and check boxes are grayed out and deactivated.

Sync Unit Cycle

The value displayed here is taken from the EtherCAT Master settings (Free run cycle time i.e. the cycle time of the EtherCAT-Master running free) as it is adjustable not at the EtherCAT Generic Slave but at the EtherCAT Master. Therefore the field is grayed out and disabled here

3.5.1 Sync 0

Checkbox “Activate Sync 0”

Sync 0 can be activated and deactivated by checking and unchecking the check box “Activate Sync 0”.

3.5.1.1 Sync 0 Cycle Time

Note: Whether this value can be adjusted or not depends on the Device Description File of the appropriate device.

The Sync 0 Cycle Time can either be derived from the Sync Unit Cycle Time adjusted at the EtherCAT Master (see above) by multiplying it with a factor or it can be entered directly.

For calculating the Sync 0 Cycle Time from the Sync Unit Cycle Time, check the check box „Sync Unit Cycle“. The Sync Unit Cycle Time is multiplied with (or divided by) an adjustable factor.

The following factors are available within the selector list:
For specifying the Sync 0 Cycle Time directly, check the check box "User defined". The value is specified in units of microseconds. The default value is 1000 microseconds. The allowed values range from 0 to 4,294,967.295 microseconds. If the specified value violates one of these limits, an error message is issued.

### 3.5.1.2 Sync 0 Shift Time

The Sync 0 Shift Time is calculated in the following way:

The Sync 0 Cycle Time is multiplied with (or divided by) an adjustable factor, the Sync 0 Shift Time Modifier.

The following values are available within the selector list:
Note: In contrast to the Sync 0 Cycle Time described above, here also the factor 0 may be chosen!

The default value for this factor is

- 0: if the chosen operation mode (see above) is *DC for synchronization*
- 1: otherwise.

Then the value specified in the input field *User defined* is added to the product. The allowed range of values extends from -2147483.648 to +2147483.647. If a value outside of these limits is specified, an error message will be issued.

The sum is displayed in the lower field having been grayed out. It is now used as the Sync 0 Shift Time.
3.5.2 Sync 1

3.5.2.1 Checkbox “Activate Sync 1”

Sync 1 can be activated and deactivated by checking and unchecking the checkbox “Activate Sync 1”.

3.5.2.2 Sync 1 Cycle Time

![Sync 1 Cycle Time Diagram]

The Sync 1 Cycle Time is calculated as the product of the Sync 0 Cycle Time (see subsection “Sync 0” above) with a positive integer factor that is specified in the input field right of Sync 0 cycle time $x$.

The range of allowed factors extends from 1 to 1024. If a value violating these limits is entered, an error message will be issued.

The product is then displayed in the grayed out field just below of the input field.

3.5.2.3 Sync 1 Shift Time

![Sync 1 Shift Time Diagram]

Figure 17: Sync 1 Shift Time
### 3.6 Process Data

In EtherCAT, the process data objects (PDO) are assigned to sync managers. A sync manager is used for synchronization of data communication on a certain communication channel. This channel is configured either for input or for output and either for cyclic or for acyclic communication. (This is defined within the device description file.) Up to 16 sync manager can be configured. These are numbered from 0 up to 15. The process data dialog only displays the sync manager which is for cyclic communication. Possible sync managers for acyclic communication is displayed in the CoE MailBox dialog.

The illustration below shows the process data dialog of the EtherCAT Generic Slave DTM:

![Process Data Dialog](image)

**Figure 18: Configuration > Process data**

The process data dialog consists of three parts:
- Sync Manager area
- PDO Assignment area
- PDO Content area
3.6.1 Sync Manager

Within the process data dialog only those PDOs can be shown simultaneously, which are assigned to the same sync manager.

The left part of the process data dialog represents the Sync Manager area which is used for choosing the sync manager to be used. It provides the Sync Manager table for choosing the sync manager whose PDOs are to be displayed, and additionally two checkboxes for PDO assignment and PDO configuration which however are relevant in case of variable configuration only.

![Figure 19: Configuration > Process data > Sync Manager](image)

The table Sync Manager displays the configuration of the sync managers for the device, as defined in its device description file (DDF). For each of the 4 sync managers available at maximum in the table, the following information is displayed:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>SM</td>
<td>Sync Manager channel number (0-15)</td>
</tr>
<tr>
<td>Byte length</td>
<td>Sync Manager length in bytes</td>
</tr>
<tr>
<td>Type</td>
<td>Sync Manager type (Inputs/Outputs)</td>
</tr>
<tr>
<td>Flags</td>
<td>Sync Manager flags (Flag F = fixed contents)</td>
</tr>
</tbody>
</table>

Table 14: Parameters Process data > Sync Manager

In case this device supports acyclic communication based on mailboxes the Sync Manager 0 is used for the mailbox output (master to slave) and the Sync Manager 1 is used for the mailbox input (slave to master).
If the device does not support acyclic communication based on mailboxes, Sync Manager 0 - 15 can be used for the Process data outputs and inputs (also see Figure Configuration > Process data > Sync Manager).

The size of the Sync Managers is defined by the assigned PDO objects. In this case the PDO object is assigned to the Sync Manager 3 and because the content of this object has the size 8 the Sync Manager is configured to 8 bytes.

The read-only checkboxes below show the download flags which are defined in device description file. They have the following meaning:

<table>
<thead>
<tr>
<th>Checkbox</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDO Assignment</td>
<td>This flag indicates whether to download PDO assignment of Sync Manager. If this flag is checked, this means that PDO assignment of the slave is writable and special CoE Init-Commands should be generated by the EtherCAT Master DTM in the Configuration Information File. These CoE Init-commands include the indices of transmit/receive PDOs. Therefore the slave knows how such PDOs are related to the Sync Manager.</td>
</tr>
<tr>
<td>PDO Configuration</td>
<td>This flag indicates whether to download PDO mapping. If this flag is set as checked, this means that PDO mapping of the slave is writable and special CoE Init-Commands should be generated by the EtherCAT Master DTM in the Configuration Information File. These CoE Init-Commands include the indices of mapped process data objects. Therefore slave knows how mapped PDOs are related to transmit/receive PDOs.</td>
</tr>
</tbody>
</table>

*Table 15: Meaning of Checkboxes*
3.6.2 PDO Assignment (Index 0x1C10- 0x1C1F)

The upper right part of the process data dialog represents the PDO Assignment area for the sync manager chosen within the left part of the window. It contains the transmit/receive PDOs.

Thus the contents of this table depends on the choice of the sync manager in the left part of the window. If a sync manager with type “Outputs” is selected, all defined receive PDOs (Index 0x1600 -0x17FF) in the device description file will be shown in this table.

Similarly, if a sync manager with type “Inputs” is selected, all defined transmit PDOs (Index 0x1A00 -0x1BFF) will be shown in this table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Activate</th>
<th>Index</th>
<th>Byte length</th>
<th>Flags</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x1C12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0x1600</td>
<td>100</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 20: Configuration > Process data > PDO Assignment

For the transmit/receive PDOs assigned to the chosen sync manager, the following values are displayed:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the PDO</td>
</tr>
<tr>
<td>Activate</td>
<td>Activation check box for assigned PDO of the selected Sync Manager</td>
</tr>
<tr>
<td>Index</td>
<td>Object index of the PDO</td>
</tr>
<tr>
<td>Byte length</td>
<td>Length of the PDO in bytes</td>
</tr>
<tr>
<td>Flags</td>
<td>Flags assigned to the PDO</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the PDO</td>
</tr>
</tbody>
</table>

Table 16: Parameters Process data > PDO Assignment
The PDO assignment is stored in a sync manager channel object within the object dictionary of the EtherCAT slave. The index of such an object is displayed in the headline of the PDO assignment area, and it has a relationship with the sync manager channel number(n):

\[ \text{Index} = 0x1C10 + n \quad (n = 0...15) \]

In the current example the information was taken from the object with the index 0x1C12 indicating sync manager 2 had been chosen for display.

For slave devices with selectable PDO assignment, PDO/PDOs can be selected from the given list of multiple fixed PDOs according to the rules defined by the device description file.
3.6.3 PDO Content (Index 0x1600-0x17FF, 0x1A00-0x1BFF)

The lower right part of the process data dialog represents the PDO Content area. It contains the mapped process data objects of the transmit/receive PDO, which has been selected in the upper right part of the window.

<table>
<thead>
<tr>
<th>Index</th>
<th>Sub Index</th>
<th>Byte length</th>
<th>Offset</th>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x200</td>
<td>1</td>
<td>0</td>
<td>Data000</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
<td>Data001</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>0x200</td>
<td>2</td>
<td>1</td>
<td>Data002</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>0x200</td>
<td>3</td>
<td>1</td>
<td>Data003</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>0x200</td>
<td>4</td>
<td>1</td>
<td>Data004</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>0x200</td>
<td>5</td>
<td>1</td>
<td>Data005</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>0x200</td>
<td>6</td>
<td>1</td>
<td>Data006</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
<td>Data007</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
<td>Data008</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
<td>Data009</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
<td>Data010</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>0x200</td>
<td>11</td>
<td>1</td>
<td>Data011</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>0x200</td>
<td>12</td>
<td>1</td>
<td>Data012</td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td>0x200</td>
<td>13</td>
<td>1</td>
<td>Data013</td>
<td>BYTE</td>
<td></td>
</tr>
</tbody>
</table>

Table 17: Parameters Process Data > PDO Content

The PDO content is stored in a transmit/receive object within the object dictionary of the EtherCAT slave. You can find the correct index of the selected transmit/receive PDO in the headline of the PDO assignment area.

In the current example the information was taken from the object with index 0x1604.

For an explanation of the navigation buttons see section “Table Line” of this document.
3.7 Mailbox

3.7.1 CoE

For slave devices supporting the CoE MailBox, the following dialog page is additionally displayed:

<table>
<thead>
<tr>
<th>CoE MailBox Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>MbxOut SM-Channel: 0</td>
</tr>
<tr>
<td>MbxIn SM-Channel: 1</td>
</tr>
</tbody>
</table>

Note: CoE Configuration is done in Master DTM!

Figure 22: Configuration > Mailbox > CoE Mailbox Settings

The dialog page provides the following information:

- The channel number of the sync manager (for mailbox input and output)
- The configured mailbox size (this applies both for the input mailbox and for the output) mailbox

The complete MailBox configuration for each slave with MailBox support is done in the EtherCAT Master-DTM.
4 Description

4.1 Overview Description

The Description pages contain the following information:

- XML Viewer page: the devices XML file content in HTML style.

**Description Dialog Pages**

The table below informs about the contents of the Description dialog page:

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Manual Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML DDF Viewer</td>
<td>37</td>
</tr>
</tbody>
</table>

*Table 18: Descriptions of the Description Pages*

*Figure 23: Navigation Area – Description*
4.2 XML DDF Viewer

The XML DDF Viewer displays the content of the DDF file of the device which is stored in an XML format.

Under Filename the absolute file directory path and the file name of the displayed DDF file is displayed. Find what offers a search feature to search for text contents within the text of the DDF file.

In the DDF Viewer window on the left side, the line number is displayed for simple overview, the further entries show the DDF file in text format.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filename</td>
<td>File directory path and the file name of the displayed DDF file.</td>
</tr>
<tr>
<td>Find what</td>
<td>Search feature to search for text contents within the text of the DDF file.</td>
</tr>
<tr>
<td>Match case</td>
<td>Search option</td>
</tr>
<tr>
<td>Match whole word</td>
<td>Search option</td>
</tr>
</tbody>
</table>

*Table 19: Device Description – XML DDF Viewer*

The XML DDF Viewer page consists of the following elements:

- **File name** shows the absolute path of the DDF file.
- **Find what** offers searching for specific text within the DDF file.
- Using the **Find Next** button allows you to jump to the next occurrence of the text to be searched for within the XML DDF file.
- Check **Match case** if you want to perform a case-sensitive search.
- Check **Match whole word** if only entire words should match and fragments of words should be excluded from matching.

*Note:* You can also access the search functionality of the XML DDF Viewer by typing Ctrl-F on the keyboard.
5 Appendix

5.1 User Rights

User-rights are set within the FDT-container. Depending on the level the configuration is accessible by the user or read-only.

To access the Configuration panes of the generic EtherCAT Slave DTM you do not need special user rights. Also all users can select the decimal or hexadecimal Display mode or sort table entries.

**Note:** To edit, set or configure the parameters of the Configuration panes, you need user rights for Maintenance, for Planning Engineer or for Administrator.

The following tables give an overview of the user right groups and which user rights you need to configure the single parameters.

### 5.1.1 Configuration

<table>
<thead>
<tr>
<th></th>
<th>Observer</th>
<th>Operator</th>
<th>Maintenance</th>
<th>Planning Engineer</th>
<th>Administrator</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>D</td>
<td>D</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Behavior</strong></td>
<td>D</td>
<td>D</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Distributed Clock</strong></td>
<td>D</td>
<td>D</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Process Data</strong></td>
<td>D</td>
<td>D</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Mailbox</strong></td>
<td>D</td>
<td>D</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

*Table 20: Configuration (D = Displaying, X = Editing, Configuring)*

### 5.2 References

[1] Device Type Manager (DTM) Style Guide, Version 1.0 ; FDT-JIG - Order No. <0001-0008-000>


EtherCAT Slave Protocol API Manual, Revision 21 (V2), Hilscher GmbH 2013
5.3 List of Figures

Figure 1: Dialog Structure of the Generic EtherCAT Slave DTM 11
Figure 2: Navigation Area 12
Figure 3: Status Bar – Status Fields 1 to 6 15
Figure 4: Status Bar Display Example 15
Figure 5: Navigation Area - Configuration 17
Figure 6: Configuration > General 19
Figure 7: Configuration > Behavior 20
Figure 8: Configuration > Behavior > State Machine Timeout - Configuration 21
Figure 9: Configuration > Behavior > Device Check 22
Figure 10: Configuration > Behavior > Process data 23
Figure 11: Configuration > Behavior > Watchdog 24
Figure 12: Configuration > Distributed Clock 25
Figure 13: Operation Mode 26
Figure 14: Sync 0 Cycle Time 26
Figure 15: Sync 0 Shift Time 27
Figure 16: Sync 1 Cycle Time 29
Figure 17: Sync 1 Shift Time 29
Figure 18: Configuration > Process data 30
Figure 19: Configuration > Process data > Sync Manager 31
Figure 20: Configuration > Process data > PDO Assignment 33
Figure 21: Configuration > Process Data > PDO Content 35
Figure 22: Configuration > Mailbox > CoE Mailbox Settings 36
Figure 23: Navigation Area – Description 37

5.4 List of Tables

Table 1: Overview Dialog Pages 4
Table 2: General Device Information 12
Table 3: Overview Dialog Panes 13
Table 4: OK, Cancel, Apply and Help 14
Table 5: Selecting, inserting, deleting Table Line 14
Table 6: Status Bar Icons [1] 15
Table 7: Getting started - Configuration Steps 16
Table 8: Descriptions of the Dialog Pages Configuration 17
Table 9: General Page Parameters 19
Table 10: Coding of Parameter "Physics" 19
Table 11: Parameters Behavior > Device checkup 22
Table 12: Parameters Behavior > Process data 23
Table 13: Parameters Behavior > Watchdog 24
Table 14: Parameters Process data > Sync Manager 31
Table 15: Meaning of Checkboxes 32
Table 16: Parameters Process data > PDO Assignment 33
Table 17: Parameters Process Data > PDO Content 35
Table 18: Descriptions of the Description Pages 37
Table 19: Device Description – XML DDF Viewer 38
Table 20: Configuration (D = Displaying, X = Editing, Configuring) 39
5.5 Glossary

CoE

CANopen over EtherCAT

CoE denominates a method for accessing an object dictionary which has been adopted for use in EtherCAT from CANopen.

DDF

Device Description File.

DTM

Device Type Manager.

The Device Type Manager (DTM) is a software module with graphical user interface for the configuration or for diagnosis of devices.

E²PROM

Electronically erasable Programmable Read-Only Memory

E-Bus

Bus system based on LVDS standard

EDS

Electronic Data Sheet

EtherCAT-Master

A device which is responsible for the configuration, parameterization of the EtherCAT segment, all connected devices’ controllers, and cyclic process data exchange, mailbox and diagnostics services.

EtherCAT-Port

Physical type of data transmission used by EtherCAT. An EtherCAT Slave Master can have up to 4 EtherCAT ports. Can be one of the following three alternatives:

• E-Bus
• 100Base-TX
• 100Base-FX

EtherCAT-Slave

A device which is configured by the Master, receives telegrams with output data, commands from it and provides input and status data.

FDT

Field Device Tool

FDT specifies an interface, in order to be able to use DTM (Device Type Manager) in different applications of different manufacturers
FMMU

Fieldbus Memory Management Unit
A field bus memory management unit organizes a mapping of EtherCAT logical addresses to physical addresses.

LVDS

Low Voltage Differential Signals

Object Dictionary

An object dictionary is a storage area for device parameter data structures. It is accessed in standardized manner very similarly as this is done in CANopen.

PDO

Process Data Objekt
Specific data object for cyclic data communication.

SDO

Service Data Objekt
Specific data object for acyclic data communication, i.e. mailbox-based communication. It is typically used for accessing the object dictionary.

Sync Manager

Synchronization Manager
A sync manager synchronizes the data communication on a specific communication channel. It is configured for managing either input or output and for working either cyclically or acyclically based on mailboxes. Configuration is done within the DDF file. Up to 4 sync managers numbered 0 to 3 can be configured.

XML

Extensible Markup Language
A versatile data storage format defined by the World Wide Web Consortium (W3C). It is based on elements and attributes. In EtherCAT, it is used in device descriptions stored in DDF files.
5.6 Contacts

Headquarters

Germany
Hilscher Gesellschaft für Systemautomation mbH
Rheinstrasse 15
65795 Hattersheim
Phone: +49 (0) 6190 9907-0
Fax: +49 (0) 6190 9907-50
E-Mail: info@hilscher.com

Support
Phone: +49 (0) 6190 9907-99
E-Mail: de.support@hilscher.com

Subsidiaries

China
Hilscher Systemautomation (Shanghai) Co. Ltd.
200010 Shanghai
Phone: +86 (0) 21-6355-5161
E-Mail: info@hilscher.cn

Support
Phone: +86 (0) 21-6355-5161
E-Mail: cn.support@hilscher.com

France
Hilscher France S.a.r.l.
69500 Bron
Phone: +33 (0) 4 72 37 98 40
E-Mail: info@hilscher.fr

Support
Phone: +33 (0) 4 72 37 98 40
E-Mail: fr.support@hilscher.com

India
Hilscher India Pvt. Ltd.
New Delhi - 110 065
Phone: +91 11 26915430
E-Mail: info@hilscher.in

Italy
Hilscher Italia S.r.l.
20090 Vimodrone (MI)
Phone: +39 02 25007068
E-Mail: info@hilscher.it

Support
Phone: +39 02 25007068
E-Mail: it.support@hilscher.com

Japan
Hilscher Japan KK
Tokyo, 160-0022
Phone: +81 (0) 3-5362-0521
E-Mail: info@hilscher.jp

Support
Phone: +81 (0) 3-5362-0521
E-Mail: jp.support@hilscher.com

Korea
Hilscher Korea Inc.
Seongnam, Gyeonggi, 463-400
Phone: +82 (0) 31-789-3715
E-Mail: info@hilscher.kr

Switzerland
Hilscher Swiss GmbH
4500 Solothurn
Phone: +41 (0) 32 623 6633
E-Mail: info@hilscher.ch

Support
Phone: +49 (0) 6190 9907-99
E-Mail: ch.support@hilscher.com

USA
Hilscher North America, Inc.
Lisle, IL 60532
Phone: +1 630-505-5301
E-Mail: info@hilscher.us

Support
Phone: +1 630-505-5301
E-Mail: us.support@hilscher.com